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Preface

How to Use This Guide

Purpose of This  The Peak Scanner™ Software Version 1.0 Reference Guide provides
Guide brief instructions for peak identification and fragment sizing for
application-specific capillary electrophoresis assays.

Audience This guide is intended for Peak Scanner’ Software users.

Assumptions This guide assumes that:

* You have downloaded and installed Peak Scanner™ Software
Version 1.0.

* You have a working knowledge of the Microsoft® Windows®
2000 or XP operating system.

Text Conventions This guide uses the following conventions:
* Bold text indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.

 [talic text indicates new or important words and is also used for
emphasis. For example:

Before analyzing, always prepare fresh matrix.

* A right arrow symbol ( » ) separates successive commands you
select from a drop-down or shortcut menu. For example:

Select File » Open » Spot Set.

Right-click the sample row, then select View Filter »
View All Runs.
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How to Obtain More Information

User Attention
Words

Two user attention words appear in Applied Biosystems user
documentation. Each word implies a particular level of observation
or action as described below:

Note: Provides information that may be of interest or help but is not
critical to the use of the product.

IMPORTANT! Provides information that is necessary for proper
instrument operation, accurate chemistry kit use, or safe use of a
chemical.

Examples of the user attention words appear below:

Note: The Calibrate function is also available in the Control
Console.

IMPORTANT! To verify your client connection to the database, you
need a valid user ID and password.

How to Obtain More Information

Obtaining
Information from
the Help System

viii

Peak Scanner'™ Software has a Help system that describes how to use
each feature of the user interface. Access the Help system by doing
one of the following:

e Click @ in the toolbar of the Peak Scanner window
* Select Help » Contents and Index
¢ Press F1

You can use the Help system to find topics of interest by:
* Reviewing the table of contents
* Find a specific topic (Ctrl-F)
» Searching though an alphabetized index
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Send Us Your Applied Biosystems welcomes your comments and suggestions for
Comments improving its user documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

Support Policy

APPLIED BIOSYSTEMS END USER SOFTWARE LICENSE
AGREEMENT AND DISCLAIMER OF WARRANTY FOR PEAK
SCANNER"™ SOFTWARE (UNSUPPORTED)

NOTICE TO USER: PLEASE READ THIS DOCUMENT
CAREFULLY. THIS IS THE CONTRACT BETWEEN YOU AND
APPLERA CORPORATION, ACTING THROUGH ITS APPLIED
BIOSYSTEMS GROUP, REGARDING THIS SOFTWARE
PRODUCT. THIS AGREEMENT CONTAINS WARRANTY
AND LIABILITY DISCLAIMERS AND LIMITATIONS. YOUR
INSTALLATION AND USE OF THIS APPLIED BIOSYSTEMS
SOFTWARE PRODUCT IS SUBJECT TO THE TERMS AND
CONDITIONS CONTAINED IN THIS END USER SOFTWARE
LICENSE AGREEMENT.

IF YOU DO NOT AGREE TO THESE TERMS AND
CONDITIONS, YOU SHOULD SELECT THE DECLINE
BUTTON BELOW TO STOP INSTALLATION. INSTALLATION
SHALL STOP AND YOU SHALL NOT USE, READ OR ACCESS
IN ANY MANNER THE SOFTWARE PRODUCTS.

This Applied Biosystems End User License Agreement and Limited
Product Warranty ("Agreement") accompanies an Applied
Biosystems Peak Scanner™ software product ("Software") and
related explanatory materials ("Documentation"). The term
"Software" includes any upgrades, modified versions, updates,
additions and copies of the Software licensed to you by Applied
Biosystems. The term "Applied Biosystems," as used in this
License, means Applera Corporation, acting through its Applied
Biosystems Group. The term "License" or "Agreement" means this
End User Software License Agreement and Limited Product
Warranty. The term "you" or "Licensee" means the purchaser or user
of this license to the Software.

Peak Scanner™ Software Version 1.0 Reference Guide ix
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1.0 TITLE

Title, ownership rights and intellectual property rights in and to the
Software and the Documentation shall at all times remain with
Applera Corporation and its subsidiaries. All rights not specifically
granted by this License, including Federal and international
copyrights, are reserved by Applera Corporation or their respective
owners.

2.0 COPYRIGHT

The Software, including its structure, organization, code, user
interface, and associated Documentation, is a proprietary product of
Applera Corporation or its suppliers, and is protected by
international laws of copyright. The law provides for civil and
criminal penalties for anyone in violation of the laws of copyright.

3.0 LICENSE
3.1. Use of the Software

3.1.1 Subject to the terms and conditions of this Agreement, Applied
Biosystems grants you a non-exclusive, personal, non-transferable
license, with no rights of sublicense, to install and/or use the
Software on single computers owned or controlled by you for the
sole purposes of managing, analyzing, viewing, editing, reporting
and printing .fsa file data generated by Applied Biosystems
instruments for your own internal research only.

3.1.2 Subject to Section 3.1.1, you may make copies of the Software
in machine-readable form. You must reproduce on any such copy all
copyright notices and any other proprietary legends found on the
original.

3.2 Restrictions

3.2.1 You agree not to copy, transfer, rent, modify, lease, lend,
translate, time-share, electronically transmit, use or merge the
Software, or the associated Documentation, in whole or in part,
whether alone or combined with any other products, except as
expressly permitted in this Agreement.

3.2.2 You agree not to reverse assemble, decompile, discover the
source code or otherwise reverse engineer the Software.

Peak Scanner™ Software Version 1.0 Reference Guide
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3.2.3 You agree not to remove any proprietary, copyright, trade
secret or warning legend from the Software or any Documentation.

3.2.4 You agree to comply fully with all export laws and restrictions
and regulations of the United States or applicable foreign agencies or
authorities. You agree that you will not export or reexport, directly
or indirectly, the Software and the Documentation into any country
prohibited by the United States Export Administration Act and the
regulations thereunder or other applicable United States law.

3.2.5 You agree not to modify, sell, rent, transfer (except temporarily
in the event of a computer malfunction), resell for profit, or
distribute this license or the Software, or create derivative works
based on the Software, or any part thereof or any interest therein.

3.3 Trial

If this license is granted on a trial basis, you are hereby notified that
license management software may be included to automatically
cause the Software to cease functioning at the end of the trial period.

3.4 Term and Termination

Subject to the rights of either Party to terminate this Agreement, the
Term of this Agreement is one year from the date of the delivery of
the Software to you. Thereafter, this Agreement shall automatically
renew for periods of one year until terminated pursuant to this
Agreement. You may terminate this Agreement by discontinuing use
of the Software, removing all copies from your computers and
storage media, and returning the Software and Documentation, and
all copies thereof, to Applied Biosystems. Upon your breach of this
agreement, Applied Biosystems may terminate this Agreement at
any time by giving written notice to you, in which case you agree to
discontinue using the Software, remove all copies from your
computers and storage media, and return the Software and the
Documentation, and all copies thereof, to Applied Biosystems.

3.5 U.S. Government End Users

Peak Scanner™ Software Version 1.0 Reference Guide Xi
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The Software is a "commercial item," as that term is defined in 48
C.ER. 2.101 (Oct. 1995), consisting of "commercial computer
software" and "commercial computer software documentation," as
such terms are used in 48 C.E.R. 12.212 (Sept. 1995). Consistent
with 48 C.FR. 12.212 and 48 C.F.R. 227.7202-1 through 227.7202-
4 (June 1995), all U.S. Government End Users acquire the Software
with only those rights set forth herein.

3.6 European Community End Users

If this Software is used within a country of the European
Community, nothing in this Agreement shall be construed as
restricting any rights available under the European Community
Software Directive, O.J. Eur. Comm. (No. L. 122) 42 (1991).

4.0 CONFIDENTIALITY

You acknowledge that the source code of the Software constitutes
confidential information of Applied Biosystems. You agree that
should you obtain access to such source code, you will protect such
confidential information by using the same degree of care, but no
less than a reasonable degree of care, to prevent the unauthorized
use, dissemination, or publication of such information as you use to
protect your own confidential information of a like nature.
Nevertheless, no obligation is imposed upon you with respect to
information that (a) was in your possession before receipt of the
Software, (b) is or becomes a matter of public knowledge through no
fault of yours; (c) is rightfully received by you from a third party
without a duty of confidentiality; (d) is independently developed by
you without reference to, and by persons which have not had access
to, Software; (e) is disclosed under legal compulsion (provided that
you first give Applied Biosystems reasonable advance notice so that
Applied Biosystems may seek to prevent or limit disclosure, and that
you cooperate with Applied Biosystems in such efforts); or (f) is
disclosed by you with Applied Biosystems' prior written approval.

5.0 DISCLAIMER OF WARRANTY; LIMITATIONS OF
LIABILITY

Xii Peak Scanner™ Software Version 1.0 Reference Guide
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5.1 THE SOFTWARE IS NOT A COMMERCIAL PRODUCT
AND IS NOT SUPPORTED BY APPLIED BIOSYSTEMS. IT IS
BEING FURNISHED TO YOU AT YOUR REQUEST AS A
COURTESY. APPLIED BIOSYSTEMS MAKES NO
WARRANTIES OF ANY KIND WHATSOEVER, EXPRESS OR
IMPLIED, WITH RESPECT TO THE SOFTWARE, ANY
GENERATED DATA, OR DOCUMENTATION, INCLUDING
BUT NOT LIMITED TO WARRANTIES OF FITNESS FOR A
PARTICULAR PURPOSE OR MERCHANTABILITY OR THAT
THE SOFTWARE, DATA GENERATED FROM THE USE OF
THE SOFTWARE (“GENERATED DATA”’) OR
DOCUMENTATION IS NON-INFRINGING. ALL
WARRANTIES OF ANY KIND OR NATURE, EXPRESS OR
IMPLIED, ARE EXPRESSLY DISCLAIMED. WITHOUT
LIMITING THE GENERALITY OF THE FOREGOING,
APPLIED BIOSYSTEMS MAKES NO WARRANTIES THAT
THE SOFTWARE, THE GENERATED DATA OR
DOCUMENTATION WILL MEET YOUR REQUIREMENTS,
THAT OPERATION OF THE LICENSED SOFTWARE WILL BE
UNINTERRUPTED OR ERROR FREE OR WILL CONFORM
EXACTLY TO ANY DOCUMENTATION, YOU
ACKNOWLEDGE THAT RESULTS THAT MAY BE OBTAINED
FROM THE USE OF THE SOFTWARE MAY NOT BE
EFFECTIVE, ACCURATE OR RELIABLE, THAT THE
SOFTWARE MAY CONTAIN BUGS, ERRORS, OMISSIONS,
VIRUSES, OR OTHER PROBLEMS AND MAY CAUSE
SYSTEM FAILURE, OR THAT APPLIED BIOSYSTEMS WILL
CORRECT PROGRAM ERRORS.

5.2 APPLIED BIOSYSTEMS HAS NO DUTY TO AND DOES
NOT INTEND TO UPDATE OR SUPPORT THE SOFTWARE IN
ANY WAY.

5.3 YOU AGREE THAT THE ENTIRE RISK ARISING OUT OF
USE OR PERFORMANCE OF THE THIS SOFTWARE, THE
GENERATED DATA, OR DOCUMENTATION AND ANY
SUPPORT SERVICES THEREFOR REMAINS WITH YOU. YOU
AGREE TO USE THE SOFTWARE, THE GENERATED DATA,
AND ANY DOCUMENTATION SOLELY AT YOUR OWN
RISK, WITHOUT RECOURSE TO APPLIED BIOSYSTEMS.
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5.4 IN NO EVENT SHALL APPLIED BIOSYSTEMS OR ITS
SUPPLIERS BE RESPONSIBLE OR LIABLE, WHETHER IN
CONTRACT, TORT, WARRANTY OR UNDER ANY STATUTE
(INCLUDING WITHOUT LIMITATION ANY TRADE
PRACTICE, UNFAIR COMPETITION OR OTHER STATUTE OF
SIMILAR IMPORT) OR ON ANY OTHER BASIS FOR SPECIAL,
INDIRECT, INCIDENTAL, MULTIPLE, PUNITIVE, OR
CONSEQUENTIAL DAMAGES ARISING OUT OF THE
POSSESSION OR USE OF, OR THE INABILITY TO USE, THE
SOFTWARE, THE GENERATED DATA OR
DOCUMENTATION, EVEN IF APPLIED BIOSYSTEMS IS
ADVISED IN ADVANCE OF THE POSSIBILITY OF SUCH
DAMAGES, INCLUDING WITHOUT LIMITATION DAMAGES
ARISING FROM OR RELATED TO LOSS OF USE, LOSS OF
DATA, DOWNTIME, OR FOR LOSS OF REVENUE, PROFITS,
GOODWILL OR BUSINESS OR OTHER FINANCIAL LOSS. IN
ANY CASE, THE ENTIRE LIABILITY OF APPLIED
BIOSYSTEMS' AND ITS SUPPLIERS UNDER THIS LICENSE,
OR ARISING OUT OF THE USE OF THE SOFTWARE OR
DOCUMENTATION OR GENERATED DATA, SHALL NOT
EXCEED IN THE AGGREGATE ONE HUNDRED UNITED
STATES DOLLARS (US$100.00).

5.5 YOU ACKNOWLEDGE AND AGREE THAT THE
WARRANTY DISCLAIMERS AND LIABILITY AND REMEDY
LIMITATIONS IN THIS AGREEMENT ARE AMONG THE
MATERIAL BARGAINED FOR BASES OF THIS AGREEMENT
AND THAT THEY HAVE BEEN TAKEN INTO ACCOUNT IN
CONNECTION WITH THE SOFTWARE PRODUCTS AND IN
YOUR DECISION TO ENTER INTO THIS AGREEMENT.

5.6 SOME STATES, COUNTRIES OR JURISDICTIONS LIMIT
THE SCOPE OF OR PRECLUDE LIMITATIONS OR
EXCLUSION OF REMEDIES OR DAMAGES, OR OF
LIABILITY, SUCH AS LIABILITY FOR GROSS NEGLIGENCE
OR WILLFUL MISCONDUCT, AS OR TO THE EXTENT SET
FORTH ABOVE, OR DO NOT ALLOW IMPLIED
WARRANTIES TO BE EXCLUDED. IN SUCH STATES,
COUNTRIES OR JURISDICTIONS, THE LIMITATION OR
EXCLUSION OF WARRANTIES, REMEDIES, DAMAGES OR
LIABILITY SET FORTH ABOVE MAY NOT APPLY TO YOU.
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HOWEVER, ALTHOUGH THEY SHALL NOT APPLY TO THE
EXTENT PROHIBITED BY LAW, THEY SHALL APPLY TO
THE FULLEST EXTENT PERMITTED BY LAW. YOU MAY
ALSO HAVE OTHER RIGHTS THAT VARY BY STATE,
COUNTRY OR OTHER JURISDICTION.

6.0 SOFTWARE IMPROVEMENTS

You acknowledge and agree that any ideas, enhancements,
modifications, and the like disclosed by you to Applied Biosystems
with respect to the Software ("Software Improvements and
Feedback") will be the property of Applied Biosystems. You agree
to assign, and hereby assign, all right, title, and interest worldwide in
the Software Improvements and Feedback to Applied Biosystems
and agree to assist Applied Biosystems, at Applied Biosystems'
expense, in perfecting and enforcing Applied Biosystems rights
thereto and ownership thereof. You acknowledge and agree that
Applied Biosystems may use such Software Improvements and
Feedback for its business purposes without restriction.

7.0 GENERAL

This Agreement shall be governed by laws of the State of California,
exclusive of its conflict of laws provisions. The United Nations
Convention on Contracts for the International Sale of Goods shall
not govern this Agreement. This Agreement contains the complete
agreement between the parties with respect to the subject matter
hereof, and supersedes all prior or contemporaneous agreements or
understandings, whether oral or written. If any provision of this
Agreement is held by a court of competent jurisdiction to be contrary
to law, that provision will be enforced to the maximum extent
permissible, and the remaining provisions of this Agreement will
remain in full force and effect. The controlling language of this
Agreement, and any proceedings relating to this Agreement, shall be
English. You agree to bear any and all costs of translation, if
necessary. The headings to the sections of this Agreement are used
for convenience only and shall have no substantive meaning. All
questions concerning this Agreement shall be directed to: Applied
Biosystems, 850 Lincoln Centre Drive, Foster City, CA 94404-
1128, Attention: Legal Department.

Peak Scanner™ Software Version 1.0 Reference Guide XV



Preface
Support Policy

XVi Peak Scanner™ Software Version 1.0 Reference Guide



Chapter 1

Getting Started
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) M About Peak Scanner™ Software v1.0 ................... 2
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B About ExampleData................................ 3
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Operating the Software
from a Command Line
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n Chapter 1 Getting Started

About Peak Scanner™ Software v1.0

About Peak Scanner™ Software v1.0

Overview Peak Scanner™ Software is a nucleic-acid-sizing software that
identifies peaks and fragment sizes for application-specific capillary
electrophoresis assays. This software allows you to annotate data
with functions such as labeling, merging, and splitting peaks. The
software stores all editing and analysis data in the original .fsa data
files generated on Applied Biosystems genetic analysis instruments.
Both GeneMapper® Software and Peak Scanner™ Software perform
analysis on original .fsa files.

Features in the » Import and analyze fragment analysis sample files (.fsa) from
Peak Scanner™ all currently supported Applied Biosystems genetic analyzers

Software * Analyzed data (sizing information) is written back to the sample
files (.fsa)

» Ability to organize the sample files in a project
» Simultaneous viewing of raw and analyzed data
» Large fragment sizing up to 1200 bp

» Ability to define the expected linear range in large fragment
size standards where non-linearity might be expected

» Expanded feature set for editing peaks that includes labeling,
merging, and splitting peaks

» Customizable sizing table

* Ability to overlay sizing curves on analyzed data

» Ability to display and print plots in thumbnail view.

» Lightweight software application with easy installation

* Ability to archive projects with sample files and associated
reference data (analysis methods, size standards and so on) for
data sharing purposes

GeneMapper® Software, another program offered by Applied
Biosystems, offers a full array of fragment—analysis applications.
For more information on the GeneMapper® Software, refer to
“Appendix A”.

2 Peak Scanner™ Software Version 1.0 Reference Guide
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Sample Files

Chapter 1 Getting Started n
About Example Data

By using Peak Scanner™ Software to analyze files you can:

» Size (in base pairs) small and large nucleic acids fragments,
such as PCR products, using an internal size standard

* Detect the presence of a peak

Analyzed data and associated information are written to the sample
files. Raw data remains unaltered. You can export sizing information
and perform downstream analysis. Using the sample files
documentation available at
www.appliedbiosystems.com/softwarecommunity, independent
software vendors can write their own software to exploit the sizing
accuracy results stored in the sample files.

Note: Peak Scanner™ Software treats a file analyzed by GeneScan®
Software as a raw data file; it does not read analyzed data.

Note: In GeneMapper® Software, all edits and projects are saved in
the GeneMapper® Software database. Peak Scanner™ Software v1.0
cannot retrieve any edits from the GeneMapper® Software, which
processes raw data in the .fsa files before analysis. Similarly, any
editing performed in Peak Scanner™ Software is not recognized by
GeneMapper® Software, which processes raw data in the .fsa files
before analysis.

About Example Data

Sample Files

Instrument and
Size Standard

Peak Scanner’" Software installs example sample files. Use these
sample files to see the functionality of the software and the variety of
application-based data that can be analyzed with the software.

Sample files were generated by running fluorescently tagged
fragments on an Applied Biosystems 3130x/ or 310 Genetic
Analyzer using the GeneScan"" LIZ® 600 Size Standard.

Peak Scanner™ Software Version 1.0 Reference Guide 3
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Peak Scanner™ Software Workflow

Peak Scanner’ Software Workflow

A typical workflow for using Peak Scanner™" Software requires that

you:

Launch the Peak Scanner™ Software.

Select a new or existing project.

Add sample files.

Select

— A size standard.

— An analysis method.

Click Analyze.

Check the plot view and sizing view panels to evaluate the size
quality.

Perform additional tasks (if needed)

— Edit peaks by merging, splitting, labeling, adding, removing.
— Compare plots through the overlay function.

— Generate sizing tables with labeled peaks.

Export or print data.

Peak Scanner™ Software Version 1.0 Reference Guide
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Starting Peak Scanner™ Software

Starting Peak Scanner™ Software

To start Peak Scanner' Software Version 1.0,

Click ok (Peak Scanner™ Software)

or

Select Start » Programs » Applied Biosystems » Peak Scanner
v1.0 » Peak Scanner v1.0.

Peak Scanner™ Software Version 1.0 Reference Guide 5
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Software Basics
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Application Layout

Application Layout
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Panels

Samples View

Plot View

Figure 1 Application layout

This panel allows you to view all samples in a project and associated
tags and parameters for analysis.

This panel allows you to view one or multiple sample file

electropherograms. You can view and edit raw and analyzed peaks,
peak labels, dye colors, and sizing curves.
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Start View

Sizing Table View  This panel allows you to view all dye-labeled peaks and their
associated characteristics.

Start View

e O O = ™ 5,-ﬁ,m.ﬁl.J>. Q.

Mew  Open  avel Gl | Edb Brit Expor  fachive Aiialyss Preferentes.
New Project Open Project

Project Mame Type Last Modifisd
vs Project File 11/29j06 1:34 P

I
Stark New Project Open Selected Project

Figure 2 Start View

New Project To start a new project:
1. Click Start New Project.

2. Add samples, assign analysis methods and size standards to
each sample.

3. Analyze the samples to view data and sizing information.

Open Project  To open a project, select from the list of displayed projects in your
Application data folder or browse to the project location.
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Application Toolbar

Application Toolbar

|

10

o o

Mew

Cpen

M.

Save Close

New
Open

Save

Close

Edit

Print

A . @ - > 0. &

Expork Archive Analysis Help Preferences

il .

—

Edit Print

Creates a new project, analysis method, or size standard.
Opens an existing project, analysis method, or size standard.

Saves the current project under the same or a new name.

Note: The default directory for saving projects is C:\Documents
and Settings\All Users\Application Data\Applied Biosystems\
Peak Scanner\Application Data. Although you can save projects in
any location, only projects saved in this default directory are
available for selection in the Start View Open Project panel. Use the
Browse button at the bottom of the Open Project panel to access
projects stored in a directory other than the Peak Scanner” Software
default directory.

Closes the current project and returns to the Start View.

Accesses the following commands:
* Undo (Ctrl+Z)
e Redo (Ctrl+Y)
o Cut (Ctrl+X)
* Copy (Ctrl+C)
e Paste (Ctrl+V)
* Fill Down (Ctrl+D)

Prints the following: Sample Table, Sizing Table, Plots, and
Thumbnails. The application prints the panel that is highlighted.
From the Plot View, you can print the Thumbnail view. (Users
cannot print the Detached Plot View directly, but can print the Plot
View from the main application window.)
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Application Toolbar

Export Exports the currently selected table data or a combined table
(samples and sizing) in a tab—delimited format (*.txt) or as a
comma- separated values file (*.csv).

To export the Sizing or the Samples Table, select the panel
containing the table to be exported, click ' # (Export) in the
application toolbar, then select Export.

Note: The Export function is enabled only when viewing the
Samples or the Sizing Table View panels.

To export the Combined Table, which contains information
displayed in both the Sample table and the Sizing table, click
Eﬁt (Export) in the application toolbar, then select Export

Combined Table.

Archive Archives or dearchives a project. You can choose the folder in which
to archive or dearchive the project. Archived projects are
compressed versions of the project files with all the associated .fsa
files.

Analysis  You can:
* Analyze Selected — Analyzes the selected files
* Analyze All — Analyzes all files in the project
* Analyze — Analyzes “ready for analysis” files

Help Opens the online Help file, which is a PDF file that you can view
with Adobe® Reader version 6.0 or higher.

Preferences Fragment Print Jobs — You can select if your print jobs are sent to
the printer in 10-page sections or combined as one print job. If the
printer has low memory, it is recommended that you fragment your
print jobs.

Display Quality Values as Images — You can change between
displaying quality values as numerical values or colored icons that
indicate pass, fail, or check.

Peak Scanner™ Software Version 1.0 Reference Guide 11
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Samples View Panel

This chapter covers:

OVEIVIEW. . . ottt e e e e 14
The Sample Explorer . ............................. 14
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Overview

Overview

Use Samples View panel to:
* Add and remove samples from a project

* Select the sample type, size standard, and analysis method
* Enter open comments in user-defined fields

The Samples View panel appears in multiple pages that display the

Sample Explorer, Samples Panel Action toolbar, and the Samples
table.

Note: The tasks available in the Samples View panel vary among
the pages and depend on the purpose of each page. However, the
tasks on many pages overlap.

Size Standard Analysis Method ShowjHide Samples: Show Al “ B e -
Sample Explorer <= |5tatus Sample Mame |Sample Type Size Standard Analysis Method |SQI ‘OFfsca\e ‘Quahty ‘UD] |UD2 |UD3 ‘
=] 1 W M Sample > v v
= Lfra z AR T Sample ~ ~ v

1MM3_ADE_GSE00LIZ_09Fe
MM3_B0S_GS600LIZ_09Fe]

;‘ENot Ready for Analysis @ Ready for Analysis Analyzed @Flle Corrupted ﬁF\Ie Locked @F\Ie Mat Found Pass mFall Dcheck
{ 4 ) problem({s) found.

-
Sample File Mame ‘Descriptinn |Prnh\em 1d |
MM3_B0S_GS600LIZ_09Feb2006_USDA-FS_004.Fsa Size standard not specified ]

MM3_B0S_GS600LIZ_09Feb2006_USDA-FS_004.Fsa Analysis methad not specified 7

MM3_A0S_GS600L1Z_09Febz006_USDA-FS_002.fsa Size standard not specified 3

MM3_A0S_GS600LIZ_09Feb2006_USDA-FS_00Z.Fsa Analysis method not specified 7

Figure 1 Samples View panel

The Sample Explorer

The Sample Explorer displays all the sample files that are included
in a project in a folder structure based on the sample file location.

The Sample Explorer can be minimized by clicking the double arrow
<<.
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The Samples Panel Action Toolbar

The Samples Panel Action Toolbar

This toolbar contains page-specific actions such as:
Add Files
To add samples to the current project:
1. Select Add Files in the panel action toolbar.
2. Browse to the .fsa files you want to add to the project

3. Select either the folder containing the files or the individual
files to be added

4. Click Add selected files, then click OK.

,_l‘_'i Add Sample Files ll
Laak in: I@ PeakSc... w I i Files Ta Add:

o Ci\Documents and Setting
Ci\Documents and Setting

@ PEAK SCAMMNER_GSG

5
Unanalyzed_Invalidss_validam.fsa
Unanalyzed_Yalidss_Invalidar.fsa
Unanalyzed_Yalidss_validam.fsa

C:\Documents and Setting

Files of bype: ISampIe Files ... = I ‘l | _’I

Add Selected Files == | Remove selected files |
K I Cancel |

Figure 2 Add Sample Files dialog box

You can also add files to a project by dragging the files/folders
directly into the open application.

Note: After you add files, the software assesses the state of each
sample for analysis and indicates this through a status column (see
below). A problems view also appears below the list of samples,
prompting you to determine the appropriate parameters necessary for
analysis, such as size standard and analysis method.

Peak Scanner™ Software Version 1.0 Reference Guide 15
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Samples Table

Remove Files

To remove samples from the current project, select the files to be
removed, then click Remove Files in the panel action toolbar.

Samples Table

This table contains a list of all samples and their associated
properties. Refer to the table below for a description of the available

fields within the table.

Column

Description

Status

Indicates the status of the sample.
The legend for the icons is below
the table. Possible states include:

Not Ready for Analysis—The
sample must be assigned the
correct size standard and
analysis method

Ready for Analysis—The sample
is ready for analysis

Analyzed-The sample is
already analyzed

File Corrupted—-The sample file
format or data is
unrecognizable by the software

File Locked—The sample file is
being used by another
application, and therefore no
data can be written to this file
until the sample file is not being
used by the other application.

File Not Found—-The sample file
cannot be located in its original
folder.

Note: The status legend at the
bottom of the samples table can
be turned on and off using the
Hide/Show Legend icon within the
panel action toolbar.

16
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Samples Table

Column

Description

Sample Name

The name of the sample is derived
from the sample name tag used
within the sample file; user
editable.

Sample Type

Indicates the Sample type:
e Sample

e Allelic Ladder

¢ Positive Control

¢ Negative Control

This field is user editable.

Size Standard

Indicates the size standard name.

Analysis Method

Indicates the analysis method
name.

Quality

The quality flag can be displayed
numerically or with an icon. The
icons are pass, fail, or check. The
sizing quality is defined in the
Quality Flags tab in the analysis
method and is user editable.

Sizing Quality Invalidated (SQI)

A green check mark indicates that
the Size Standard peaks definition
for the particular sample has been
manually edited by the user and,
therefore, the Sizing Quality
automatically generated by the
software is invalid.

Offscale

Indicates if the sample contains
offscale peaks.

If a green check mark is displayed,
the fluorescence signal was
greater than the maximum
readable signal on the Genetic
Analyzer. To correct offscale data,
adjust the amounts of labeled
fragments. The software cannot
correct for offscale data. Although
offscale samples can still be
analyzed, their peak sizes may not
be accurate.

Peak Scanner™ Software Version 1.0 Reference Guide
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Problem View

Column Description

uD1 A user-defined field where you can
make notes or comments about
the samples.

ub2 A user-defined field where you can
make notes or comments about
the samples.

uD3 A user-defined field where you can
make notes or comments about
the samples.

After addition of samples to the current project, the software displays
the sample type, the status of the sample, the quality, and any
associated problems. Problem descriptions appear below the Status
legend, if applicable.

Problem View

18

The Problem View is displayed only if a sample has a problem that
prevents the sample from being analyzed. This view contains a list
of all samples and their associated problems.

Sample file not found
The sample file has been moved from its original folder location, and
the application can no longer find the link to the file.

Sample file in another open project

The sample file is a read-only file because it is already open in
another application. The sample can be viewed, but no changes such
as analysis or peak editing can be made to the file.

Note: Closing the open file in another application does not make the
file available for editing. The only way to fix this problem is to
remove the locked file from the project, close the open file, then re
import the file into the project.

Peak Scanner™ Software Version 1.0 Reference Guide
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Problem View

Size standard not specified

The sample file does not have an associated size standard. To
resolve this issue, define the size standard for the file.
Assigned Size standard not found

The size standard name associated with the sample file cannot be
found by the application. To resolve this issue, define a different
size standard for the file.

Analysis method not specified

The sample file does not have an analysis method specified. To

resolve this issue, define an analysis method for the file.

Assigned analysis method not found

The analysis method name associated with the sample file cannot be
found by the application. To resolve this issue, define a different
analysis method for the file.

Peak Scanner™ Software Version 1.0 Reference Guide 19
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Show/Hide Samples

Show/Hide Samples

You can show/hide samples in one of the following ways:
» Show all samples contained in the project by selecting Show
All from the Show/Hide Samples drop-down list.

» Hide samples by selecting the samples you want to display in
the Samples table of the Sample Explorer, then selecting Show
Only Selected from the Show/Hide Samples drop-down list.

Note: Samples that are hidden remain in the project, but are not
viewable in the samples table, plot view, and sizing table.

* Hide samples by selecting the samples in the Samples table,
then selecting Hide Selected from the Show/Hide of the
Show/Hide Samples settings in the Panel Action toolbar.

———————————————————————————————— — —————
Show/Hide Samples: Shawe All n m .T.I.[” 9 .

|Shai Only Selected |
Hide: Selected

Figure 3 Show/Hide Samples

Note: This action is not available in the Set Analysis Parameters
page.
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Hide Status Legend

You can hide the sample status legend by clicking I-% (Hide
Legend) in the Samples View Panel Action toolbar.

Edit Table Settings

Note: This action is not available in the Set Analysis Parameters

page.

Users can display, hide, order, and sort columns in ascending or
descending order. In addition to the fields described in the “Samples
Table” on page 16, additional information generated from the Data
Collection Software after samples are processed is indicated below.

Fields Description
Panel Panel name
| Matrix Matrix name
SNP Set SNP Set name
Run Name Run name

Instrument Type

Instrument type

Instrument ID

Instrument ID

Run Date Run date
| Sampile File Sample file name
Cap/Lane Capillary number or lane number
Plate Name Plate name
Well Well location in plate

Auto Sampler tube

Auto sampler tube name

DC version

EP Current

Data Collection software version

Electrophoresis current value

Peak Scanner™ Software Version 1.0 Reference Guide
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Fields Description
EP Power Electrophoresis power value
EP Voltage Electrophoresis voltage value

Injection Time

Injection time

Injection Voltage

Instrument Name

Injection voltage

Instrument name

Laser Power

Laser power

Module File

Run module file

Number Channel

Channel number

Number Avg Channel

Average channel number

Number Cap/Lane

Run Duration

Number of capillaries or lanes

Run duration

Total Data Points

Number of total data points

Temperature

Temperature

Well to Read distance Well to read distance or capillary

length

To change the Samples Table settings, click .._.I.LI (Edit Table
Settings) in the Samples View Panel Action toolbar.

You can do the following:

Add Sample
Fields to Display

In the Available Columns to Display section highlight the fields to
add, then select Add Selected OR Add All to add every available
field. Click Apply to apply the changes to the current project.

Remove Sample In the Columns Selected section highlight the fields to remove, then

Fields from sclect Remove Selected OR Remove All to remove every field.
Display Click Apply to apply these changes to the current project.
Adjust the Order Select the field whose order needs to be changed, then use the Move
of Fields in the Up or Move Down buttons to adjust the display order.
Table
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Edit Table Settings

Sorting  Adjust the sort order of a column from ascending to descending by
selecting from the drop-down list in the Sort Order Field of the
Columns Selected table.

You can sort fields within the application by Alt clicking the field
header. An arrow appears indicating the sorting order followed by a
number designating the column number. Repeating the Alt-click on
the same header changes the sort order from ascending to descending
and vice versa. Alt-Shift clicking in a second column provides
secondary sorting, in a third column tertiary sorting, and so on.

Note: To apply any table setting to the current project, you must
click Apply.

Saving a Sample You can save table setting templates to be used in a future project.
Table Setting To do this, adjust the Sample Table Settings, then click Save or Save
Template As. The files are saved to: C:\Documents and Settings\All Users\
Application Data\Applied Biosystems\Peak Scanner\Application
Data\Sample Table Settings.

Apply a Saved Select a previously saved Sample Table Setting from the Sample
Sample Table Table Settings drop-down list, then click Apply.
Settings

Peak Scanner™ Software Version 1.0 Reference Guide 23
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Defining the Sample Type

Defining the Sample Type

In the Sample Type column, select a sample for which to specify
sample type, then select one of the following:

) —

— —
Add Files | Remove Files | Size Standard Iz‘ Analysis Method Iz‘

=

|Status |SampIeName ﬁSampIeType \Sizestandard |AnalysisMethod |SQI |OFFscaIe |Quality |UD1 |UD2 |UD3 |

Explorer

Sample

Negative Control

Positive Control

Allelic Ladder

26

1 Walidss_Irvalidam| | Sample
z Unanalyzed_vali, | | =

Positive Contral

ES600LIZ [ sizing Default PP =]

bseooliz [ SeingDefadk  [¥]

Figure 1 Sample Type

Any DNA specimen or sample.

A sample that contains no DNA but all other reagents used in the
experiment.

A sample that contains a known DNA sample and all appropriate
reagents and that generates positive data if the experimental
conditions are performed correctly.

A sample of DNA that contains a combination of the most common
alleles for a specific marker or set of markers.

Note: The Sample Type field is displayed by default in the Set
Analysis Parameters page, but can be added to the other pages using
the Edit Table Settings function.

Note: To copy the same column value in a set of selected samples,
highlight the cells of interest, then use the fill down function
(CtrI+D). The column value that is applied is copied from the top-
most cell of the selected cells.

Note: Peak Scanner™ Software does not perform allele calling but
GeneMapper® Software can.
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Defining the Size Standard

Defining the Size Standard

Under the column heading Size Standard, select the drop-down list
to choose the size standard used for each sample.

— I
Add Files | Remove Files | Size Standard Iz‘ Analysis Method Iz‘

Er I |Status |Sample Mame Sample Type /Size Standard \Analysis Method |SQI |OFFscaIe |Quality |UD1 |UD2 |UD3 |

Jh Validss_Irvalidat | Sample Sizing Default NFP [ ]
« Unanalyzed_vali... Sample

zing Default Iz‘

G5500LIZ_3730
ShPlex_48plex_w1
55500{-250ILIZ

ple Explorer

Figure 2 Size Standard

Size Standards A collection of DNA fragments of known lengths within a range (for
Definition example, 20 to 600 bp) all tagged with the same dye. The size
standard is co-injected into the genetic analyzer capillary with the
sample, then used to size the sample data. All Applied Biosystems
size standards are labeled with a proprietary dye, Rox™" (red) or
VIC® (orange) dyes.

Note: When the analysis method file name does not match any of
the analysis method filenames in the folder AppliedBiosystems\PS\
Appdata\AnalysisMethod, it is displayed in bold text. When the
analysis method file name appears in the size standard folder
AppliedBiosystems\PS\Appdata\AnalysisMethod, but its analysis
method definition does not match the analysis method file definition
in the folder, it is displayed in italic text.
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Defining the Analysis Method
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Under the column heading Analysis Parameter, select the drop-down
menu to choose the analysis method.

Add Files | Remove Files | Size Standard Iz‘ Analysis Method Iz‘

I |Status |Sample Mame Sample Type |Size Standard /|Analysis Method \ |SQI |OFFscaIe |Quality |UD1 |UD2 |UD3 |
ValidSs_InvalidiM | Sample [+] aseonL1z ||| Sizing Default
%] Sizing Defaulk MPP

‘ﬂ

Unanalyzed_vali...

Sample [*] seooL1z

[Sizing Diefaulk

i

Figure 3 Analysis Method

The two default analysis methods provided with the Software are:
Sizing Default and Sizing Default NPP.

Using the Sizing Default analysis method assumes that primers have
not been removed from the sample. The Sizing Default NPP (NPP=
no primer peak(s)) should be used for samples that do not contain
primers or have had primers removed.

Note: When the size standard file name does not match any of the
size standard filenames in the folder AppliedBiosystems\PS\
Appdata\SizeStandard, it is displayed in bold text. When the size
standard file name appears in the size standard folder
AppliedBiosystems\PS\Appdata\SizeStandard, but it’s size standard
definition does not match the size standard file definition in the
folder, it is displayed in italic text.
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Creating and Editing Size Standards

In the Set Analysis Parameters page, you can create and edit the size
standards in individual sample files and save these changes for future
use. You can be do this in the New Size Standard or the Manage Size
Standard page.

M Peak Scanner

23.0.H.-9 4.8 -8 -

New  Open Coss Edt Pk Egot  Ahive analysis Help  Preferences

Froject> Size Standard Editor,

3 Setup

ot

=3 ]

Descrpton |Facary Provied ]

Enter sizes , space, o, the "Acid Size(s)>>"

= Quaiity Controt

Edit Size Standerds

I NEEC S

Add Szefs) >>

3. Resource:

e od

X CO06_2002-05-10_. o

_Run_C006_2002-05-10_ 105 1352 o 1150 13

_2002:05-10_ % 790 o 183 un

_2002:05-10_ 136 1258 o 1212 1201

55 CO06_E109_Run_C0D6_2002-05-10._, i 72 o 1224 1218

56 COn6_E109_Run_C0D6_2002-05-10_, 218 1999 o 1237 1228

57 CO06_E109_Run_C0D6_2002-05-10._, 162 1311 o 1261 1251
o

v Applied 56 coe 109 5 20020510, 125 17 1263 1210 ‘@
ARG <
D Biosystems |3

Figure 4 Create or edit new size standards

Create and Edit  You can create or make edits to individual sample files. These edits
Size Standard in  will not affect other samples.
Sample File

Create and Edit You can create or make edits to the saved Size Standard file. These
Size Standard in  edits are applied to all samples using the size standard.
Folder
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Creating and Editing Analysis Method

Extract to folder You can save the size standard for the selected sample file to the
folder to be available in the drop-down list for the current and future
projects.

Creating and Editing Analysis Method

In the Set Analysis Parameters page, you can create and edit
individual file analysis methods and save the changes for future use.
This can be done in the Analysis Method or Manage Analysis page.

1 Peak Scanner [-[=]x]
- T R R S - a - . .
New  Open | sae  Chee ER | Pt Bpot | Acwe | Anayss telp | preferences
Project> 1 Analysis Method Editor... X
e R
32 Setup fome: [ I
. p— ] I

[Peak Detecion | Qualty Fags|

= Quaiity Controt

Es

i
od: Bssepars v |fo Lt 5] @

5 Resources

New Size St Revert o Defauks

Manage Analysis Methods

) ahom Showalpeds v e i v RO

[oye/sample peak | sample Fil Name. ES Height areainpont |areaingp Data Pt [segin paint JEE

[ ] B 1 C006_E109_Run_C006_2002-05-10._. 174 4156 o 1109 1082 |
[ | B2 C006_E109_Run_C006_2002-05-10._. 105 1352 o 1150 132
[} 83 C006_E109_Run_C006_2002-05-10._. £ 790 o 1183 1
[ | B4 C006_E109_Run_C006_2002-05-10._. 136 1258 o 1212 1201
[} 85 C006_E109_Run_C006_2002-05-10._. 7 732 o 1224 1218
[ | 86 C006_E109_Run_C006_2002-05-10._. 218 1999 o 1237 1228
[} 87 C006_E109_Run_C006_2002-05-10._. 162 1311 o 1261 1251

[ | 88 C006_E109_Run_C006_2002-05-10._. 125 1187 o 1283 1270 -9

Cotets  RBBIEC] % wman

Figure 5 Create or edit new analysis method

Create and Edit  You can create or make edits to the individual sample file. These
Analysis Method edits do not affect other samples.
in Sample File
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Creating and Editing Analysis Method

Create and Edit  You can create or make edits to the saved Analysis Method file. The
Analysis Method edits are applied to all samples using this Analysis Method.
in Folder

Extract to folder You can save the Analysis Method for the selected sample file to the
folder to be available in the drop-down list for the current and future
projects.
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Creating and Editing Analysis Method
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Overview

Overview

The Plot View Panel allows you to view and review
electropherograms and to annotate data. The Plot View Panel is
activated immediately after analysis of sample files but also can be
accessed using the task action toolbar from multiple pages. After
data analysis, the plot panel can be independently launched in a new
window to maximize the viewing experience. You can also minimize
the Plot View Panel to gain more screen space for the Samples and
Sizing Table View Panels.

The Plot View Panel displays one or more selected
electropherograms of raw and/or analyzed data and their
corresponding dye legends as well as a Plot View Panel Action
Toolbar that varies slightly in functions based on the selected page.

Plot View Panel Action Toolbar

The four pages on the Task Pane are: Edit Size Standards, View,
Label Peaks, and Edit Peaks.

Note: The tasks available in the Plot View Panel vary among the
pages and depend on the purpose of each page. However the tasks on
many pages overlap.

Scaling and  The axis scaling is determined by the viewing mode. You can select
Viewing the viewing mode of the data in the Plot Panel Action Toolbar or in
the Display tab of the Plot Setting window from the Data drop-down
menu.
Data X-Axis Scale Y-Axis Scale
Raw Scan number or data points Relative fluorescence units
Analyzed Size (base pairs) Relative fluorescence units
Raw and Analyzed Size (base pairs) Relative fluorescence units

34
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Chapter 5 Plot View Panel ﬂ
Plot View Panel Action Toolbar

At the top of each electropherogram, the data type for each sample is
coded by an information bar.

Data Information bar color
Raw Light green
Analyzed Light blue
Raw and Analyzed | Light purple

& Allows you to show or hide selected dye

color data from the display using the plot panel action toolbar. Click
a colored icon to show or hide peaks of that color. A check mark
indicates that the color is displayed. This setting is applied to all
samples selected for viewing. The data remain in the sample files.
This option is also available in the display tab of the plot settings.

LIk
|"ll"Displatys brackets that define minimum peak detection limit,
peak start and end points, and peak height.

iy Allows you to restore the plot view to include all data and
restore original view by clicking the full view icon.

& Displays a dialog box that allows allows you to edit, save, and
apply plot settings. See below for more information.

Creates a new window that displays all selected plot views in the
format that is currently displayed (for example, if you turn off the
blue color and view raw data, the new data are displayed in the
thumbnail view). You can print the thumbnail views. The sizing
curve is not displayed in the thumbnail view.
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Electropherogram  The following functions are available in the Electropherogram plot.

Features

Check Box Zooming

e

Data; Analyzed

(@) "F109_Run_C006_2002-05-10_205_01.fsa AnalyzedData | [V]*F,  COO5_E109_Run_COD6_2002-05-10_205_01.fsa Analyzed Data
o\«n 120 160 200 240 o> Dyelegend 80 120 160 200 240 o> Dyelegend
20 [m w0 Jco \200 [m w0 Jco
1000 1000
500 a0
500
100 s
200 400 .'

5 ! 200 M J
ol L i
£, B3 3 < >
[(T*% ) coos_E109_Run_Caos_z002-05-10_205_01.fsa Analyzed Data |\7] ¥, COD5_EL09_Run_CO06_2002-05-10_205_01.fsa Analyzed Data
= 120 160 200 240 =>  Dyelegend &0 120 160 200 240 =>  Dyelegend
120 S&o 2o mmiL0 o
100 1000
&0 800
50 500
10 J‘ J J 100
20 200
J .dl‘l ) A dhn .J‘I Al I“l.
< > < >

Scrolling along axes
Dye Legend

Figure 1 Electropherogram features
Check boxes

You can select the box in the upper left corner of each
electropherogram to enable zooming of multiple sample
electropherograms. After you select an electropherogram you can
use CTRL - A to select all sample electropherograms.

Scrolling along axes ﬁ

In some modes, the scrolling bar may temporarily be removed from
view. To reactivate the scrolling function, click k4 in the left
portion of the information bar.
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Plot Settings

- -
Zooming A

You can change the magnification of the electropherogram by
placing the pointer over the x- or y-axis until a magnifying glass icon
appears. Drag the magnifying glass icon over the area on the axis
where you want zooming (a highlighting box appears). You can
return to the original view by clicking ju (Full view) in the Plot
Panel Action Toolbar or by double-clicking the axis on which
zooming was originally performed.

Alternatively, you can use tools in the Scaling and Zooming tab in
the Plot Settings dialog box.

Dye Legend

The dye legend appears when the Show Color Legend box is
checked under Plot Settings (See next section). To the right of each
electropherogram, the Dye Legend indicates the displayed dye colors
and their relative scale. The default color and scale are preset, but
can be customized for ease of viewing or for normalization of peaks
within or among samples. The dye legend view can also be
minimized by clicking the double arrow >>.

To change a displayed dye color, double-click the right colored
square to choose a different color. To modify the scale for a
particular dye, click the scale indicator, then change the number.
Custom colors and scaling can also be personalized through the
Scaling and Zooming tabs in the Plot Settings dialog box.

Plot Settings

You can adjust a variety of plot settings. Collectively, a group of
specific settings can be saved in a plot settings file to apply to
specific projects. These plot setting files are saved in C:\Documents
and Settings\All Users\Application Data\Applied Biosystems\
Peak Scanner\Application Data\Plot Settings
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Plot Settings

The plot settings are categorized by their effects on display, labeling,
and scaling and zooming.

Display Tab

M Diot Settings

Apply Settings: | v
(Sattings i this windiow s apiy o o piots)
Display | Lahels | Scaling and Zooming
Flot Panes Contral Sample Fanes Display Dyes
O single Panes [#] Contrals to top
: [Fi
Muriber of Panes ] (@ Single Panes
(@) Checker Board Number of Panes A |
Stacking Options:
rows | [ O Checker Board
== i1 - ContineOyes [TE) sopera yes (1] overoy
colmns |8 v El L &
columns |8 v
Dats to display | TENEEEEE | Sellect From raw data, analyzed data, or raw + analyzed data
Show: [¥] Color Legend [ ] Cuskom Colars Reset Display Colors [[] OFfscals Indicator [ ] Owetlay Sizing Curve Fullview [ ] Peak Position
v
£ >

Figure 2 Plot Settings - Display tab

Control and Experimental Sample Plot Panes

Single Panes: Displays one or more electropherograms in a serial
fashion.

Checkerboard: Displays more than one electropherogram in a grid

layout by selecting the number plots shown per row and column.

Note: Electropherograms from control samples can be displayed in a
similar manner and can precede electropherograms from
experimental samples during viewing by selecting the “controls to
top” check box.

Display Dyes

Combine Dyes: Displays one plot combining all dye color data sets.
This setting is the user default.

Separate Dyes: Displays individual plots for each dye color data set
for each sample.
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Overlay All Dyes: Displays one plot with all color dye data
superimposed from selected sample files.

Show Color Legend

Shows or hides dye legend.

Show Custom Colors

Preselects custom colors for each displayed dye if the box is
checked. Unchecking the box returns all displayed dye colors to their
original colors.

Reset Display Colors

Returns all custom colors, which are user-selected directly, from the
dye legend to their original dye color.

Show Offscale Indicator

Highlights the offscale peaks in the plot view panel if the box is
checked. Refer to “Offscale” on page 17 for a definition also
available in the Panel Action toolbar on the “view” page under
review data.

Overlay Sizing Curve

Allows the sizing curve to be overlaid directly on the
electropherogram of an analyzed sample.

Show Full View

Refer to “Full View” on page 35.

Show Peak Position

Refer to “Show Peak Positions” on page 35.

Peak Scanner™ Software Version 1.0 Reference Guide 39



ﬂ Chapter 5 Plot View Panel

40

Plot Settings

Labels Tab

Display | Labels | Scaling and Zooming

M plot Settings

Apply Settings: | Praject v

(Settings i iz window wif aoply to all plots}

Labels to Show Labeling Options Arrange Labels

[IHeight (H) [#] show Labels

Dlareata) Label Peaks | (A %] From: [ e [ | @bk Horisorisl Labsl

[¥]5ize (5) g z A f— Ol vertical Label
-C\EarLahe\s | | From: | | Tar | |

[pata Paint (D} (@ ]

[ comment (C) [Iretain labels

Figure 3 Plot Settings - Labels tab

Labels to Show

You can select peak information to be displayed through check
boxes (peak height, peak area, size, data point, user comment)
Labeling Options

You can decide which peaks should or should not be labeled based
on height, area, or size using the drop-down list. Click Label Peaks
or Clear Label to perform selective actions.

IMPORTANT! The Show Labels check box must be selected for
labeling to take effect.

Retain lables

OFF: When you click a peak, the labels are displayed. When you
click a peak whose labels are displayed the labels disappear. You can
click a peak once to see the labels, then click again to hide the labels.

ON: When you click a peak, the labels are displayed. When you
click a peak whose labels are displayed the labels remain displayed.
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Arrange labels
You can align peak labels horizontally or vertically on the x-axis of

the electropherogram by selecting the appropriate icon.

The Scaling and
Zooming Tab

i plot Settings

Apply Settings: | [Project v/ [ saveas

(Settings i iz window wif aoply to all plots}

Display Labelsﬂ Scaling and Zooming |

fads Settings Scale Dyes

¥ s

@ cale each plot individualy Mo |@[re |O[e W10 |[H[xo

(O seale all plots to maximum ¥ value

H Ais Zooming

@ s5cale gach plot Individuslly

O Seale all plots to maximum % value Zoom ¥ axis relative to selected peak

@Basepairs Zoomxawdis | fom (00 | o [ 100000, ]

O seans

v

< »

Figure 4 Plot Settings - Scaling and Zooming tab

Axis settings

You can scale electropherograms of selected samples individually or
based on the maximum x or y value of a series of electropherograms.
The data mode refers to the x-axis units for viewing, namely
basepairs or scan number.

Scale Dyes

You can adjust the dye scale for normalization of dye intensities by
entering a numerical value. The default for all dyes is set to 1.0

Zooming

You can zoom in on a region of the electropherogram based on one
or more criteria.

» Selected peak — Rescaling the y-axis based on the peak height in
relative fluorescent units of the peak.
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* Defined y-axis value — Rescaling from 0 to a user-defined y-
axis value in relative fluorescence units.

* Defined x-axis range — Rescaling based on user-defined x-axis
range where values depend on the data mode (basepairs or
scans) selected in the axis settings.

Plot Panel Associated Pages

42

Add Samples to
Project Page
(Under Setup

Section)

Edit Size
Standard Page
(Under Quality
Control Section)

Functionality of the Panel Action toolbar may change from page to
page.

You can access the Plot View Panel by selecting il (Plot) in the
TaskAction toolbar for viewing raw data. The Plot Panel Action
Toolbar allows for dye selection, stacking, plot setting options, and
thumbnail views of selected electropherograms.

After samples are analyzed, you can select this page to view/alter the
size-standard definition. The analyzed data in the electropherogram
display peaks that are associated only with the internal size standard
(e.g. GeneScan™ LIZ® 600 Size Standard) and the associated sizing
curve of the selected sample. In this mode, you can select peaks to be
included or excluded in the sizing curve by assigning their relative
sizes based on the size-standard definition.

Peak selection is performed by clicking the peak of interest (in all
pages where peak selection is appropriate). After the peak is
selected, the area under the peak is filled in with the appropriate dye
color. You can select multiple peaks simultaneously by pressing the
CTRL or SHIFT key while making selections. You can deselect
peaks by clicking on the peak again.

After you select a peak, peak information is displayed below the
peak, and peak information is highlighted in the sizing table. You
can perform one of the following actions:

Add label

Allows you to include a peak in the sizing curve and subsequently
assign a size to that peak based on the size-standard definition.
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Delete label

Removes the peak from the size-standard definition by assigning a
size of 0 bp.

Replace label

Changes the peak size to another size listed in a drop-down list of the
size-standard definition.

When these actions are performed, the Sizing table is updated with
the changes simultaneously.

Changes to the size standard prompt you to reanalyze the sample, as
indicated by the Ready for Analysis icon. Samples must be
reanalyzed after editing the sizing curve.

View Page (Under The Plot View Panel is displayed after data analysis by clicking
Review Data): Analyze. This panel is also displayed on page selection. The Plot
View Panel Action Toolbar allows you to change viewing mode, dye
selection, stacking, plot setting options, offscale peak designation,
and thumbnail views of selected electropherograms.

Detach Plot View

To maximize your viewing size, you can create a new window that
displays only the electrophoretic views of selected sample files.
Click the Detach Plot View of the Display mode preferences at the
top of the Task Action Toolbar. Closing the window, returns you to
the current project view. This option is available in all pages under
the Review Data section. This page can be printed by selecting
Detached Plot View, then selecting Print in the task panel.

Label Peaks Page After data analysis the plot panel is available on page selection. The
(Under Review Plot Panel Action Toolbar allows for shortcuts to labeling
Data) preferences described in the plot settings/preferences, such as

showing labels based on specific criteria, label display parameters
(height, area, size, user comment), and label alignment (vertical or
horizontal). When space is limited for full label display, the labels
are minimized into square icons. You can obtain peak information by
placing the pointer over the appropriate icon and reading the tooltip.

Each Peak can be labeled with the following :
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Edit Peaks (Under
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Review Data)

H-Height

A—Area

S—Base Pair position

D-Scan number

C—Open comment field for users to enter text

You can select the appropriate parameters using the drop-down
menu under “Display” in the Panel Action Toolbar. To start labeling
(“Labels Tab” on page 40), click Show labels.

After data analysis, the plot panel is available on page selection. This
page allows you to redefine, add, delete, merge, and split peaks,
which may be necessary during cases of sample overloading, a
typical sample migration due to contaminants, and suboptimal
resolution.

You can place the pointer over a peak to select it. A bin defining the
peak is shown in gray. The bin boundaries and peak apex are each
indicated by vertical lines. Place the pointer over the peak, then right
click to obtain the drop-down menu for peak editing. You can
perform the following actions:

Range select:

Allows you to select one or more peaks for editing. The selected
section will appear in yellow.

Add peaks:

Allows you to add and enter into the sizing table peak information
that was not included in the original analysis.

Merge peaks:

Allows two individual peaks to be treated as a single peak. The new
“bin” is automatically determined. Such a function is typically used
for offscale peaks, where overloading of sample results in peak
splitting.
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Plot Panel Associated Pages

Split peaks:

Allows you to separate a single peak into two peaks. The new bins
are automatically determined for both peaks by the software. This
option is commonly used when two peaks are not completely
resolved.

Remove peaks:

Allows you to remove extraneous peaks that may results from dye-
labeled primers, contaminants, or nonspecific PCR amplification.
Information associated with a particular peak is subsequently deleted
from the sizing table, but the peak is still displayed in the plot view.
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The Sizing Table
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Figure 1 Sizing Table

The Sizing Table View panel allows you to view peak information
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for the selected samples within the Samples View panel. The Sizing
table contains a list of all peaks for the selected samples from the

Samples Table with properties that are associated with each peak.

Column

Description

Dye Color

Indicates the peak dye color.
Possible states are blue, green,
yellow, red, and orange.

Dye/Sample Peak

Sample File Name

Assigns a name to each peak.
The format is color, peak number.

Indicates the Sample file name.

Size

Height

Indicates the peak size based on

base pairs.

Indicates the peak height.

Area in Point

Area in BP

Data Point

Indicates the peak area based on
scan number.

Indicates the peak area based on
base pairs.

Indicates the peak data point or
scan number.

Begin Point

Indicates the begin point of the

peak based on the scan position.
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Column Description

Begin BP Indicates the beginning of the
peak based on basepairs.

End Point Indicates the end point of the peak
based on the scan position.

End BP Indicates the end point of the peak
based on basepairs.

Width in Point Indicates peak width based on
scan numbers.

Width in BP Indicates peak width based on
basepairs.

User Comments Allows you to make notes or

comments about the peaks.
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The Sizing Table View Panel Toolbar
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Show

Label Selected
Peaks

You can change displayed data in the sizing table based on the filter
you select.

You can hide sizing table peaks by selecting peaks to keep, and then
selecting Show Selected Peaks from the drop-down list in Show.
Peaks that are hidden remain in the project, but will not be viewable
in the sizing table.

You can filter the sizing table to show only peaks that are labeled by
selecting Show Labeled Peaks from the drop-down list in Show.
Peaks that are hidden remain in the project, but are not viewable in
the sizing table.

You can show all samples contained in the project by selecting Show

All from the drop-down list in Show.

You can display a peak label from the Sizing Table. To label peaks
in the plot view using the Sizing table, select the sample peaks from
the table, then select Label Selected Peaks.

Note: To label peaks, you must select Show labels in the display tab
of Plot Settings.
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The Sizing Table View Panel Toolbar

Avalable Columns to Display
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Figure 2 Edit Table Settings

You can adjust the column order and sorting to customize your data.
Additional files that you can include or remove from the table are

described in the table below.

Column

Description

User Edit

Indicates if the peak has been
modified by the user. User-
modified peaks are indicated as
Edited. If a peak has not been
modified, the cell is empty.

Project Name

Includes the name of the Project.

Run Name

Run Date

Indicates the run name.

Indicates the run date.

Run Duration

Shows the run time sample.
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The Sizing Table View Panel Toolbar

To change the Sizing Table Settings, select Edit Table Settings
from the Sizing Table View panel action toolbar, then you can do the
following:

Add Sizing Table fields to Display

Highlight the fields to add from the Available Columns to Display
table, and select Add Selected or Add All (to add every available
field), then click Apply to apply the changes to the current project.

Remove Sizing Table fields from Display

Highlight the fields to remove from the Columns Selected table,
select Remove Selected or Remove All (to remove every field), then
click Apply to apply the changes to the current project.

Adjust the Order of Fields in the Table

Select the column whose order needs to be changed, then use Move
Up or Move Down to adjust the order.

Adjust the Sort Order

Adjust the sort order from ascending to descending by adjusting the
drop-down list within the Sort Order field of the Columns Selected
table.

Apply a Saved Sizing Table Settings

Select a previously saved Sizing Table Setting from the drop-down
list, then click Apply. You can also save the table settings to be used
in a future project. To do this, adjust the Sizing Table Settings, then
click Save or Save As. These files are saved to: C:\Documents and
Settings\All Users\Application Data\Applied Biosystems\Peak
Scanner\Application Data\Sizing Table Settings.

Note: To apply these saved changes to the current project, you must
click Apply.
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Sorting Tables

All tables within the application can be sorted by Alt-clicking the
field header. Repeating the Alt-click on the same header changes the
sort order from ascending to descending and vice versa. Alt-shift
clicking in a second column provides secondary sorting, in a third
column tertiary sorting, and so on.

Export

You can export the displayed sizing table by clicking Export in the
Application Toolbar, then selecting Export. This function allows
you to export table data as either a Tab Delimited format (*.txt) or a
comma separated values file (*.csv).

To export the Sizing or the Sample table, select the panel containing
table to be exported, click Ew{t (Export) from the application toolbar,
then select Export.

Note: The Export selected table option is enabled only when the
Samples or the Sizing Table View panels are displayed.

To export the Combined table, which contains information displayed

in both the Sample and Sizing tables, click Exp-gt (Export) in the
application toolbar, then click Export Combined Table.

Print

You can print the displayed sizing table by clicking Print in the
Application Toolbar, then selecting Print.
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Overview

Overview

This appendix explains how to load, analyze and export data from
the command line interface of the Peak Scanner™ Software.

IMPORTANT! Applied Biosystems supports the use of the command
line interface only as it is explained in this manual.

Note: If you are unfamiliar with Microsoft® DOS, Applied
Biosystems recommends running the application from the user
interface.

About the Interface

The primary advantage of the Peak Scanner™ Software command
line interface is that it can automate most software operations
without using the graphical user interface. If incorporated as part of a
batch file or a scripted sequence, the commands can eliminate most
of the repetitive, data-entry tasks associated with project analysis.
Use of the command line interface is intended for advanced users
(such as systems administrators, bioinformaticians, and network
administrators) who choose to operate the application using a
scripting language.

Command Syntax

56

Commands are issued to the Peak Scanner’" Software command line
interface via the MS-DOS shell of the Windows® operating system.

The basic format for all commands is:

<PeakScanner.exe> -commandline <arguments> where:

* < PeakScanner.exe> is the path and filename of the executable
file for the Peak Scanner™ Software.

* -commandline is the argument that placed the software into
command line mode. -cmd can also be used.
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+ <arguments> is the series of arguments that specify the
operation(s) to be performed.

Creating a Batch File to Run the Peak Scanner™
Software

This section explains how to use the command line interface of the
Peak Scanner”" Software by creating a batch file for the Windows®
operating system. The use of batch files is a convenient method to
author and submit command line commands to the Peak Scanner™
Software; however, use of the command line interface is not limited
to the method demonstrated here.

To create the batch file

1. In the desktop, open the Windows Notepad accessory (Start »
All Programs » Accessories » Notepad.

2. Press Enter to create a new line.

3. In the Notepad window, enter the following:
“PeakScanner” -commandline -project “project”

where:

* PeakScanner is the directory path for the Peak Scanner™
Software executable

* “project” is the name of the project to create or analyze
(enclosed in double quotes).
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4. After the -project argument, enter any additional arguments to
instruct the Peak Scanner’™ Software to perform the desired
functions.

IMPORTANT! Follow the guidelines below when entering
commands

» Type all arguments on the same line of text (the command
cannot contain hard or soft returns)

* Enclose the user-defined component of arguments in double
quotes (for example: -project “my project”)

» Separate all arguments using a space (ASCII character 32).

5. (Optional) After typing the last argument in the command,
repeat steps 3 through 4 to enter additional commands.

Note: The operating system executes the commands in the order that
they appear in the batch file (from top to bottom).

6. When finished, carefully review the text of the batch file for any
€rrors or typos.

7. When satisfied with the content of the file, save the text as a
batch file:

a. Select File » Save.
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b. In the File name field, enter a name for the batch file that
terminates in the .bat file extension. For example:
mybatchfile.bat or PeakScanneranalysis.bat

c. Click Save.

8. Select File » Exit to close the batch file.

To run the batch file, double-click the file icon and wait for the
computer to run the scripted command.

Note: Depending on the speed of your computer and the number of
commands included in your batch file, the operating system may
take several minutes to a number of hours to process the batch file.

Example Commands

Example Example #1: Create or Edit a Project with Sample files
Commands in

This Section Example #2: Basic Sample File Analysis with Analysis Method &

Size Standard
Example #3: Export of Sample data, Sizing Data & Combined Data

Example #1: Basic Sample File Analysis

Purpose: This command was written to create a project with sample
files. This batch file creates a project called “Micorsat.pjc” and adds
the sample files in the C:\Test Data FSA\temp folder.
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Example #2: Basic Sample File Analysis with Analysis Method &
Size Standard

Purpose: This command was written to analyze sample files by
setting the analysis method and size standard.

Example #3: Export of Sample Data, Sizing Data & Combined
Data

Purpose: This command was written to export the sample data,
sizing data, and the combined data for the sample files of an existing

project.
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Tips & Suggestions

+ When you copy from a Microsoft® Word® document to a text
file, some characters are decoded incorrectly. Therefore, you
must manually enter the text document..

For example quotes [ “ ] are decoded as 0.
* Turn on Word Wrap in the text pad. Select Format » Word

Wrap.

* Do not use the Enter key to go to the next line. This happens
automatically with Word Wrap on.

Argument

Action/Definition

Usage

-commandline

Configures the Peak Scanner™
Software to operate in command
line mode.

-commandline

-project Specifies the project to be created | -project “projectpath”
or opened. The argument of this
option is the path of a valid Peak
Scanner project. Both absolute
and relative paths are supported. If
the project file exists, the project is
open. Otherwise, a new project is
created.

-folder Specifies the path of the folder -project “projectpath” —folder “c:\\
from where sample files can be temp”
added. This command when used
with a project loads the samples in
the folder into the project

-file Specifies the path of the sample -project “projectpath” file “filel,
file. This command when used file2” Can specify more than one
with project loads the samples in file
the folder into the project

-analysis Analysis is performed on the -project “projectpath” -analysis
samples in the specified project. OR
Optional parameters with this are
-analysismethod and -project “projectpath” —analysis
-sizestandard . “ »

-analysismethod “ampath
—sizestandard “sizestdpath”
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Argument

Action/Definition

Usage

-analysismethod

Specifies the full path of the
analysis method to be used for
analysis. This is an optional
parameter.

-project “projectpath” —analysis

-analysismethod “ampath”

-sizestandard

-exportsampledata

Specifies the full path of the size
standard to be used for analysis.
This is an optional parameter.

Exports the sample table
information from the specified
project. Supported export formats
are CSV and TAB.

-project “projectpath” —analysis

-sizestandard“sizestdpath”

TAB

-project “projectpath”
- exportsampledata
“sampletable.txt;tab”

Csv

-project “projectpath”
-exportsampledata
“sampletable.csv;csv”

-exportsizingdata

Exports the sizing table
information from the specified
project. Supported export formats
are CSV and TAB.

TAB

-project “projectpath”
-exportsizingdata
“sizingtable.ixt;tab”
Csv

-project “projectpath”
-exportsizingdata
“sizingtable.csv;csv”

-exportcombineddata

Exports the sample table and
sizing table information.
Supported export formats are CSV
and TAB.
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-project “projectpath”
- exportcombineddata
“samplessizingtable.txt;tab”

Csv

-project “projectpath”
-exportcombineddata
“samplessizingtable.csv;csv”
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Appendix A &

Features of GeneMapper® Software

* Sizing Algorithm

* Multiple Algorithm Allele Determination for Microsatellite-
Based genotyping

* Remote auto-analysis and distributed computing

* Multi-user, client server deployment

* Security and audit features which assist with 21CFR11
requirements

* Process Quality Values (PQVs) for high-throughput genotyping

* Applications include amplified fragment length polymorphism
(AFLP), loss of heterozygosity (LOH), microsatellite, and SNP
genotyping (SNPlex ™ Genotyping System) analysis

* Automatic Bin Assignment

* Automatic Bin Builder (ABB)

* SNP Allele Caller: Auto-Panelizer

* Cluster plot analysis and display for SNPlex " assay genotyping
provides easy-to interpret visualization of allele calls

+ Complete automation with ABI PRISM® 3100 or ABI PRISM®
3100-Avant Genetic Analyzers, Applied Biosystems 3130 and
3130x/ Genetic Analyzers, and Applied Biosystems 3730 and
3730x/ DNA Analyzers allow data collection and analysis on
one computer

» Database Manager helps you organize and manage your data
* OLA-Analysis method for certain oligo ligation assay

* (OLA)-based mutation analysis

 Plot and Printing views
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